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AI in PowerPoint

AI is clearly the new hotness at the moment, and it’s being applied to everything. 

Something old, something new, something borrowed, something generated from 

a large language model. PowerPoint is the something old. A tool that we all use 

so much, it’s pretty much like breathing at this point. The advantage of 

PowerPoint is that everyone uses it and it’s easy to share with a common format, 

so incorporating AI into PowerPoint is clearly a sensible approach. At least, unless 

and until something completely mind-blowing comes along.

The issue is that AI in PowerPoint itself is still relatively new and very immature. 

There are some things you can do now, but I’d encourage you to consider the 

right tool for the job, and that may mean expanding into a few other tools – 

certainly for now.

To me, generative AI tools are often best – at general scale – for text generation 

and comprehension, image creation, and very soon video production.

Text content | use tools like ChatGPT, Copilot, and Gemini to play through ideas, 

refine content, and interrogate the end result to see if it’s relevant for the 

audience.

Image generation | custom images that allow you convey a precise idea from 

Dall-E, Midjourney, Stable Diffusion, and Adobe Firefly.

Video | check out Sora from OpenAI for the concept. Try Dream Machine for five 

second clips (perfect for GIFs). And then more current tools like Descript, Peech, 

and Colossyan for simpler generation and easy editing capabilities.

However, effective presentations typically need so much more than this, with 

visual storytelling requiring meaningful visuals, diagrams, and animated 

sequences that convey the ideas clearly, in a form that allows you to present to 

multiple people simultaneously and/or respond to the audience in front of you. 

And so far, I’ve not seen compelling evidence that AI delivers this in the one-click 

experience we’re all expecting. That means we will all have jobs for a while, and 

that you need to find AI tools to help you get there, but you’ll still be doing a lot 

of the work.

https://chatgpt.com/
https://copilot.microsoft.com/#/home
https://gemini.google.com/app
https://openai.com/index/dall-e-3/
https://openai.com/index/dall-e-3/
https://openai.com/index/dall-e-3/
https://www.midjourney.com/home
https://stability.ai/
https://www.adobe.com/products/firefly.html
https://openai.com/index/sora/
https://lumalabs.ai/dream-machine
https://www.descript.com/
https://www.peech-ai.com/
https://www.colossyan.com/
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Copilot & Designer

Copilot

Microsoft’s big push in AI for Office 365 comes in the form of Copilot. It appears 

as a chat pane on the right-hand side of your slide and allows you to use natural 

language to create, edit, and refine your presentations. Copilot for Office 365 is a 

subscription service, with options available for individuals, small businesses, and 

enterprise. It’s great in text-based applications like Word and Outlook, but it 

seems to be early stages in graphical PowerPoint decks. Use it as a tool to help 

you get there, rather than seeing it as something that does it all for you.

Introducing Microsoft 365 Copilot – your copilot for work

Copilot in PowerPoint help & learning

Designer

While Copilot currently lacks design sense, Designer, unsurprisingly, has loads of 

it. Currently available as a free tool online, Designer allows you to do all sorts of 

creative tasks using generative AI. Creating custom images, removing 

backgrounds,, editing images, and, perhaps most usefully of all, creating layouts 

and designs for all manner of content. You can’t, currently, push it straight into 

PowerPoint, but it gives you a JPG, PNG, PDF, or MP4 file output that could be 

incorporated into your slide deck.

Microsoft Designer - Stunning designs in a flash

https://blogs.microsoft.com/blog/2023/03/16/introducing-microsoft-365-copilot-your-copilot-for-work/
https://blogs.microsoft.com/blog/2023/03/16/introducing-microsoft-365-copilot-your-copilot-for-work/
https://blogs.microsoft.com/blog/2023/03/16/introducing-microsoft-365-copilot-your-copilot-for-work/
https://support.microsoft.com/en-us/copilot-powerpoint
https://designer.microsoft.com/
https://designer.microsoft.com/
https://designer.microsoft.com/
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ChatGPT for PowerPoint

ChatGPT & Copilot in a browser

You can create a free account and head over to OpenAI or simply open Copilot 

on a browser or use the Bing app on your phone.

From there, you can ask it to create text and images for you, although separately. 

That could form the basis of some of your presentation content, but it won't help 

you design your slides or pace your story with animations.

ChatGPT on OpenAI

Copilot | Bing

ChatGPT for PowerPoint

If you don't have access to Copilot for any number of reasons and you want to try 

our generative presentation creation, head over to the Home tab in PowerPoint.

From there you can click the Add-ins tab and search for ChatGPT. There are a few 

templates to choose from and options to create decks from several sources, 

including a simple prompt. There's a free trial after which you can choose to 

subscribe at $8.99/month.

ChatGPT for PowerPoint

https://chatgpt.com/
https://copilot.microsoft.com/
https://www.bing.com/chat
https://appsource.microsoft.com/en-us/product/office/WA200005566
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Some of the biggest problems people facing when creating presentations in a 

corporate environment is finding the right content and ensuring that it’s 

consistent and on-brand. BrandIn provides a content library for templates, slides, 

and groupings of slides, images, icons, diagrams, graphs, charts, tables, and any 

other component you would use to make a slide, so that people can quickly and 

easily create content using appropriate material.

Included is Brand Check – like a spell checker for your brand – applying various 

rules and AI tools to bring any custom content in line with the rest of the deck.

BrandIn is a paid service designed for enterprises. We’re hoping one day to 

release a version that cater better to small teams.

This short three-minute video gives you a sense of

what BrandIn is, why it’s useful, and how it works, 

along with a short demo of the tool in the final 

minute. A demo version of BrandIn with dummy 

content is also available.

BrandIn

Watch the video

https://www.brightcarbon.com/introduction-to-brandin-for-powerpoint/
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Noun Project

What’s better than five million icons? Five million icons directly in PowerPoint. The 

Noun Project is a fabulous resource of every icon you could ever want and the 

add-in brings all of those icons into PowerPoint. It’s very simple and that’s all it 

needs to be really.

Actually, you can do a little more, with the ability to change the colour of the 

icons before you insert it into PowerPoint, but as the icon is inserted as an SVG, 

which you can modify in PowerPoint, this may not be that useful.

Noun Project has a free version, with only a small selection of icons available. To 

unlock all of them required a subscription of $40 per year, which many agree is 

excellent value.

Noun Project

Noun Project in the Office Store

https://thenounproject.com/
https://appsource.microsoft.com/en-in/product/office/WA104381063?tab=Overview
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Pexels

Pexels is one of the best free stock photo sites out 

there and all of those beautiful, high-quality images 

are available to you directly in PowerPoint through 

the Pexels add-in.

It’s pretty simple. The add-in gives you a pane on the 

right-hand side of PowerPoint with a search bar for 

images. Click the image you like, select the small, 

medium, or large size, and it will appear on the slide.

What’s quite neat is there is also a colour picker that 

allows you to filter by images with specific colours in. 

You’ll get better or worse results depending on the 

image type, but if you want a nicely corporate pink-

based image, you can select the colour and then see 

the options available.

Pexels

Pexels in the Office Store 

https://www.pexels.com/
https://appsource.microsoft.com/en-in/product/office/WA104379997?tab=Overview
https://appsource.microsoft.com/en-in/product/office/WA104379997?tab=Overview
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Build-a-Graphic

Build-a-Graphic is an add-in for PowerPoint that has 

all the graphics you could probably ever want – over 

10,000 at current count.

What makes it unique compared to standard 

graphics libraries is that it helps you to actually build 

a graphic for a presentation, report, or infographic. 

If you have a text-based slide, you can use a keyword 

search to come up with a suitable graphic that you 

can copy/paste text-based content into. Often the 

graphics include icons that you can also customize. 

And as it’s all vector-based you can modify all the 

other elements to make it your own.

You can also browse or search the library for 

individual elements to build your own custom 

graphic. This means you aren’t forced to fit your story 

into a pre-defined graphic, but can ensure it does 

precisely what you need to.

The graphics are all vector-based, so they scale to 

whatever size you like, don’t have a huge impact on 

file size, and you can break them apart and 

customize.

Build-a-Graphic is available as a subscription product 

at $199 per year.

Build-a-Graphic PowerPoint Add-In

20% discount code: Bright20

https://billiondollargraphics.com/build-a-graphic/
https://billiondollargraphics.com/build-a-graphic/
https://billiondollargraphics.com/build-a-graphic/
https://billiondollargraphics.com/build-a-graphic/
https://billiondollargraphics.com/build-a-graphic/
https://billiondollargraphics.com/build-a-graphic/
https://billiondollargraphics.com/build-a-graphic/


www.brightcarbon.com

info@brightcarbon.comBrightSlide



BrightSlide

Created by PowerPoint experts at BrightCarbon, the BrightSlide add-in will help 

you create, polish, and edit presentations at speed. It draws on industry-standard 

shortcuts to boost your workflow and provides amazing, extra functionality 

PowerPoint users have only dreamed of. 

We developed BrightSlide as the ultimate productivity add-in to tackle the pitfalls 

of PowerPoint. And, because we love the presentation community almost as 

much as we love PowerPoint, we share BrightSlide with you for free!

Align with precision Save animation 

combinations

Easy custom grids Update slides in 

seconds

Advanced 

typography

Swap objects with 

ease

‘So long’ to the 

Selection Pane

Super shortcuts

Tidy and tame 

tables

 Download here

Download

here

Download 

here

https://www.brightcarbon.com/brightslide/
https://www.brightcarbon.com/brightslide/


BrightSlide | Match Tools

The Format group has a collection of tools that help you save time by making editing multiple objects at once, or copying complex formatting, super simple.

Size Painter and Position Painter make use of the reference point setting for 

added flexibility. This sets the point where your objects get resized from, and 

how they get aligned. When painting size, having the reference point set to 

centre will resize all objects from their centrepoints. When painting position, 

the central reference point setting will reposition all of your target objects so 

that their centrepoints perfectly overlap.

Paint Format and Format Painter+ do a number of different things depending 

on what you use it on. At its core, it acts exactly like the Format Painter you 

know from PowerPoint. But you can also use it on charts and tables, easily 

allowing you to copy a table’s or chart’s formatting to another table or chart.

Adjustment Painter copies adjustment settings from one object to another. 

This is great for ensuring all of your rounded rectangles are using a consistent 

corner radius throughout your content, or making sure that your chevrons all 

look the same.

Multi-painter allow you to copy size, position, formatting, 

adjustments, and animations from any object to any other 

object.

These tools work like any other painter in PowerPoint, except 

we’ve made them sticky by default so you can copy properties 

across slides and presentations.

If nothing is selected, you can pick up properties from the slide 

itself — like size and position. This is great for filling the entire 

slide with an image.

The painter can be used in Batch Mode or Solo Mode. Batch 

Mode turns the tool into a customisable Multi-painter, which 

allows you to paint multiple properties in one go. Using the 

painter in Solo Mode will separate the five settings into 

individual Painters which you can add to your Quick Access 

Toolbar.

Download 

here

https://www.brightcarbon.com/brightslide/


BrightSlide | Match Tools

The Format group has a collection of tools that help you save time by making editing multiple objects at once, or copying complex formatting, super simple.

Match Size and Match Position make use of the reference point setting for 

added flexibility. When using Match Size, having the reference point set to 

centre will resize all objects from their centrepoints. When using Match 

Position, the central reference point setting will reposition all of your target 

objects so that their centrepoints perfectly overlap.

Match Format does a number of different things depending on what you use 

it on. At its core, it acts exactly like the Format Painter you know from 

PowerPoint. But you can also use it on charts and tables, easily allowing you to 

paste a table’s or chart’s formatting.

Match Adjustments copies adjustment settings from one object to another. 

This is great for ensuring all of your rounded rectangles are using a consistent 

corner radius throughout your content, or making sure that your chevrons all 

look the same.

Match Tools allow you to copy size, position, format, 

adjustments, and animations from any object to any other 

object.

These tools match your selection to the reference object. The Set 

Reference Object setting can be found by clicking Settings in the 

BrightSlide tab.

If a single object is selected, the slide itself will become the 

reference object — this is great for filling the entire slide with an 

image.

The tool can be used in Batch Mode or Solo Mode. Batch Mode 

turns the tool into a customisable Match Tool, which allows you 

to match multiple properties in one click. For example, turning 

on size, adjustments, and format will match those three 

properties in one click. Using the tool in solo mode will separate 

the five settings into individual Match Tools which you can add 

to your Quick Access Toolbar.

Download 

here

https://www.brightcarbon.com/brightslide/


BrightSlide | Animation Tools

BrightSlide’s suite of animation tools make complex animations a breeze to create.

Animate to Reference Object (Animate to Last | Animate to 

First) | Automatically add animations that match the position, 

scale, rotation, fill color, outline color, and text color of the 

reference object. Please select two or more objects to use. 

Depending on your setting in BrightSlide, the reference object 

can either be the last selected, or the first selected object — the 

name of the feature will reflect what setting you currently have 

active. The Set Reference Object setting can be found by clicking 

Settings in the BrightSlide tab.

The options window allows you to exclude certain types of 

animations from being added. You can also toggle reverse 

animations on and off — reverse animations animate all shapes 

back to their original properties.

My Animations | We designed the animation library for our 

designers, but it was too good not to share! Our designers are 

amazing animators, but were tired of having to repeatedly 

recreate the same sequences or copy and paste animations from 

one presentation to another. My Animations is a library of 

animation sequences that you can add to any object with just 

one click to give a consistent, professional, and polished feel to 

your content. You can add your own custom sequences, 

including timings and settings, so your favorite animations are 

always close at hand. We’ve pre-stocked your animation library 

with a few lovely sequences to get you started.

1. Select object to be animated

2. Click My Animations

3. Select sequence

Download 

here

https://www.brightcarbon.com/brightslide/


BrightSlide | Animation Tools

BrightSlide’s suite of animation tools make complex animations a breeze to create.

Paste as Motion Path | Easily create motion paths from freeform 

shapes. Simply copy* a shape you wish to use as a motion path, 

select the target object, and apply this feature.

By default, the target object will be kept in its initial position. By 

shift-clicking, you can keep the motion path in its initial position 

and move the target object there.

*Windows only. On macOS, use the Copy as Motion Path button 

to copy your freeform shape as a motion path.

Motion Path Tools can be found by clicking Utilities in the 

Animation group.

Waterfall Delay | Add a cascading waterfall delay to all 

animations applied to selected objects. Before BrightSlide this 

would have taken forever, but our handy add-in can 

automatically stagger your animations for a smooth, 

professional look.

Settings give you control over timings and which animations the 

tool applies to. You can add a delay to every object or every 

animation on every object.

1. Select the objects that have the animations you wish to 

stagger (selecting animations in the Animation Pane is not 

supported)

2. Click Waterfall Delay

3. Choose your settings and click OK

Waterfall Delay can be found by clicking Utilities in the 

Animation group.

Download 

here

https://www.brightcarbon.com/brightslide/
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Slidewise

Slidewise is a fabulous add-in that allows you to 

analyze all the details of your file. It helps you to find, 

control, and replace, unwanted fonts, large 

image/media files, and broken links. It can highlight 

colours that are wrong or if you have too many slide 

masters.

The full version is a subscription product that costs 

$79 per user per year. There is also a free version that 

shows you the fonts used, large images, and an 

overview of the file size – but it’s worth noting you 

can’t automatically fix these issues.

Slidewise PowerPoint Add-in

https://neuxpower.com/slidewise-powerpoint-add-in?
https://neuxpower.com/slidewise-powerpoint-add-in?
https://neuxpower.com/slidewise-powerpoint-add-in?
https://neuxpower.com/slidewise-powerpoint-add-in?
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Vectorizer.AI

Very simply, Vectorizer.ai turns images into vectors. 

JPG, PNG, and other raster graphics often don’t scale 

well as the pixels are fixed, and so just get larger. File 

size can also potentially be an issue are larger image 

sizes. And trying to edit the image requires 

Photoshop wizardry.

Vectorizer.ai turns the image into a vector file that 

will scale beautifully, generally be of lower file size, 

and give you more flexibility to modify the graphic.

You could potentially use it on actual photos, but you 

usually get a very stylized image that’s unlikely to be 

useful. But to recreate diagrams and charts that you 

can then modify, it’s a fabulously useful tool in 

presentations, allowing you to update, resize, and 

recolour complex diagrams and charts fairly easily.

Vectorizer.ai is currently free to preview, but to 

download content is either $10 per month through 

the web, or you can buy a package of credits for an 

API to use through add-ins for various graphics 

packages.

BrightCarbon is currently working on an add-in to 

use Vectorizer directly within PowerPoint, but 

Vectorizer still need to finalizer a few things before 

this can be launched. Hopefully soon. For now, use it 

on the web.

Web direct | Vectorizer.AI

https://vectorizer.ai/


www.brightcarbon.com

info@brightcarbon.comTranslate & subtitles



Translate & subtitles

Translate is a feature that’s been in 

Office applications for a long while. 

You can find it on the Review tab in 

the ribbon, and then Translate.

You can select any object, choose 

from one of 62 different languages, 

and then translate that object, or 

modify the automatic translation 

before you change the object on the 

slide.

Translate text into a different 

language - Microsoft Support

There are quite a few related 

elements for translation, including in 

the Subtitling functions in 

PowerPoint. In fact, there is a 

dedicated Presentation Translator 

app that you can download from 

Microsoft and find out more about 

their efforts in general.

Presentation Translator for 

PowerPoint - Microsoft Translator

Real-time subtitling in PowerPoint allows you to capture what you’re saying and 

either overlay, or create a windowed area for the subtitles to appear. You can turn 

these on mid-slide show using the option buttons in the bottom left of the slide 

show window, from the presenter view screen, or through the Slide Show tab 

and the Always Use Subtitles check box. In the settings you can also choose to 

change the language to one of 62 different options.

Present with real-time, automatic captions or subtitles in PowerPoint

Related to this is Live Presentations, that allows you to share your slides with 

people, but they can also see a live transcription of what you’re saying, and then 

choose their own translation language for a more personalized experience.

Present Live: Engage your audience with Live Presentations

https://support.microsoft.com/en-us/office/translate-text-into-a-different-language-287380e4-a56c-48a1-9977-f2dca89ce93f
https://support.microsoft.com/en-us/office/translate-text-into-a-different-language-287380e4-a56c-48a1-9977-f2dca89ce93f
https://support.microsoft.com/en-us/office/translate-text-into-a-different-language-287380e4-a56c-48a1-9977-f2dca89ce93f
https://support.microsoft.com/en-us/office/translate-text-into-a-different-language-287380e4-a56c-48a1-9977-f2dca89ce93f
https://www.microsoft.com/en-us/translator/APPS/PRESENTATION-TRANSLATOR/
https://www.microsoft.com/en-us/translator/APPS/PRESENTATION-TRANSLATOR/
https://www.microsoft.com/en-us/translator/APPS/PRESENTATION-TRANSLATOR/
https://www.microsoft.com/en-us/translator/APPS/PRESENTATION-TRANSLATOR/
https://support.microsoft.com/en-us/office/present-with-real-time-automatic-captions-or-subtitles-in-powerpoint-68d20e49-aec3-456a-939d-34a79e8ddd5f
https://support.microsoft.com/en-us/office/present-with-real-time-automatic-captions-or-subtitles-in-powerpoint-68d20e49-aec3-456a-939d-34a79e8ddd5f
https://support.microsoft.com/en-us/office/present-with-real-time-automatic-captions-or-subtitles-in-powerpoint-68d20e49-aec3-456a-939d-34a79e8ddd5f
https://support.microsoft.com/en-us/office/present-live-engage-your-audience-with-live-presentations-039aa2cc-67fa-4fb5-9677-46ed8a060c8c
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Presenter Coach

Being able to rehearse the delivery of your presentations, with feedback and 

suggestions is a great use of AI – probably balanced with feedback from real 

people if you can.

Access it on the Slide Show tab on the ribbon, and then Research with Coach. 

Ideally present for at least a minute to give it enough material to work with, and 

then, once you’ve finished, review the report it generates to see what it thinks 

and how you might improve.

Rehearse your slide show with Speaker Coach

https://support.microsoft.com/en-us/office/rehearse-your-slide-show-with-speaker-coach-cd7fc941-5c3b-498c-a225-83ef3f64f07b
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Cameo video

Incorporate a live webcam feed into your presentations with Cameo video to connect better with your audience and be part of the presentation.

Incorporate a live webcam feed into your 

presentations with Cameo video to connect better 

with your audience and be part of the presentation.

Insert > Cameo

The Cameo placeholder can be positioned anywhere 

on the slide and have graphics incorporated behind 

and in front of it to integrate it better into the slide.

Ensure that it doesn’t block any useful content, but if 

you would like to appear behind content, for an 

augmented reality style presentation, ensure that 

there is sufficient contrast between your video feed 

and the content.

It’s also possible to fill the slide with a Cameo video 

so that you appear full screen, which may be suitable 

for discussion, Q&A, or when there isn’t any relevant 

slide content to show. Consider having a full screen 

slide somewhere hidden in your deck, so that if you 

need it, you can type the slide number and enter to 

jump to that slide for full screen video.

The Cameo video works with the Morph transition, 

so you can move seamlessly between slides.

The camera turns on during slide show, but will not 

take over from a video feed in Teams or Zoom, so be 

sure to turn off your video first.
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